In this guide will he for Photoshop newhies hut also anyone looking for some tins
(the workflows and tips should still carry over to any image-editing software]

The views expressed in this content are satirical and should not be taken seriously.
U just want people to learn something]
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JANIEOHEONENTS

Setting up the image for editing: Page 3
¢ Unlocking layer
e Creating first Smart Object

Removing the Background: Pages 4-5
e Mask characters from background
(Using Select & Mask windows)
e Masking hair
e Adjusting Masks

Adding a new Background: Page 6
e Importing gradients
e Making custom color gradients
(Iconic MAP Stipes & Smooth gradients)

Recoloring Clothing: Pages 7-10
e Masking each item
e Adding colored gradient
e Clipping masks
e Levels adjustments

Recoloring Clothing (Extras): Pages 11-13
e Painting colors
e Working with colored clothing other than white
e Using other Adjustment Layers
e Removing patterns from clothing

Text & Layer Styles: Pages 14-16
e Formating & coloring text
¢ Adding Layer Styles
e Warping text

Text & Layer Styles (Extras): Pages 17-18
¢ Shaping Text
¢ Other Blending options

Tattoos & Decals: Pages 19-21
¢ Warping tattoo with body
¢ Blending tattoos with skin
¢ Lighting & recoloing tattoos
e Using Clipping Mask/Mask Layer
¢ Adding decals & other objects

Editing Background: Pages 22-23
e Smart filters
e Custom Backgrounds

Advanced Editing: Page 24
® Removing genital censors

Resources: Pages 25-27
* Websites to find material
* Premade MAP & other assets
¢ Additional Software to use
* [mage viewers
e |nteractive Font viewer
e External Color picker

Credits: Page 28
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For this tutorial we’ll create an edit of Kanna in a white bikini and a simple white
background. This will be the easiest color to mask for recoloring

Setting up the image ready for masking

Q Kind JE e TR ®

Normal v Opacity: 100% v

Lock: ’

New Layer... Shift+Ctrl+N
New Group...

Duplicate Layer...

Quick Export as PNG ~ Shift+Ctrl+"
Export As... Alt+Shift+Ctrl+*

Flatten Image

Lock Layers... Ctrl+/
Rename Layer...

Hide Layers Ctrl+,

Blending Options...

New Group from Layers...
Frame from Layers...

New Artboard...
Artboard from Layers...

Convert to Smart Object

Mask All Objects
Paste Layer Style

Copy CSS
Copy SVG

Color

Any changes made to the original image
will update the Smart Object in the main

project once you save it

Simple press Ctrl+S (or File > Save)

Dragging an image into
Photoshop it’ll appear as a
locked Background so first
we need to quickly convert

it into an editable layer

Simply double click empty
space on the Background
layer to bring up the New

Layer window

(Here you can rename it
anything) then click OK

49

@

Currently it’s a just
raterized image

We need to convert it into
a Smart Object so we can’t
mess up the original
source artwork

Now just right click the

layer and select

Convert to Smart Object

Tutorial Project.psd

D 36.8% (Layer 0, RG

New Layer

Name: Layer 0

(X] None

Normal

Color:

Mode: Opacity: 100

If you ever need to get to the
original raterized image
(for inpainting/re-drawing
elements)
then you can just double click
the thumbnail
and it’ll open up a new
Photoshop window to access it

This is the same for anything
you convert into a Smart Object




Separating the character from the background - Part 1

In recent versions of Photoshop they introduced some tools to help you mask out people, objects
and remove the background for you. These would be great if they worked reliably for our use case
but unfortunately they’re not great for drawn characters.

‘ Try them out if you’re
| 9® Adistcolors | A @ e struggling and you can clean
up the mask in later steps

For now we’ve got three tools we could use, however as the
background is a simple white color and the characters outline is nice
and bold, the Magic Wand tool is perfect for this task (for now)

Tolerancea Anti Using the Magic Wand tool Pressing the Shift key will allow
you’ll want to select all parts you to add to the current selection
e of the background

] 2 (Pressing Alt will do the opposite)

You might need to lower the Tolerance

amount if some selections are too aggressive Keep selecting X
all parts of the

bakground untill
you’re sure all white
is selected

You will struggle to select these parts O
(Will be covered in next section so ignore)

This technique is only selecting the simple
background however we want to swap that to
only selecting the character as we’re masking

the character from the background

Right Clicking on a selected area should bring
up a drop down menu to allow you to
Select Inverse

Nocala~+

- % ( (SelectInverse)) |

Feauii=rees

Select and Mask...

You’ll know you’ve only selected the character if the dotted lines
around the image boarder have gone leaving only ones around the
subject

Now we can move onto making our
Mask Layer (Click Select and Mask...)



Separating the character from the background - Part 2

Now we’re in the Select & Mask window
we can start making adjustments to get the most out of our mask

Now switching to using the Refine
Edge Brush tool we can go over those
awkward areas where background
isn’t constant

As this is our only layer we can
change the background transpareny
to 100% to see what’s left to remove

Show Edge ()
Vies Shor Okl (b) T Refine Edge Brush Tool

Refine selection edges and enhance
edge details. Best used with the
"Show edges” checkbox enabled
and Edge Detection radius slider..
Learn more

9 High Qualiy Preview

Transparency

Brush tool

Fine-tune selection by brushing over

areas you want to select or remove. % * %
Learn more I‘

Using this tool we can paint around

It’s never perfect as it can sometimes

fade the outline of our character but the edges of our character and you'll
we can repaint them in using the see the background started to fade
Brush tool away
Brush Tips: Use the Magnifier tool to help you

zoom in and out

Holding down Shift or Alt will switch
to + or - for any Brush

To Increase or Decrese the size of the

Brush, hold down Alt + Right Click
whilst moving your mouse left or
right

),

When you’re happy with
removing all background
elements we can Output our

OutputTo  Layer Mask

New Layer with Layer Mask

New Document mask into Layer Mask

New Document with Layer Mask

You can always go back into the mask to fix up any

) Q Kind @2 e THn e
spots you’ve missed or could do better by Double . -
jormal v pacity: % v
Clicking the mask = o
k: [ Q@  Fill: 100% -

This will bring up the Select & Mask window again

hauelly



Adding a MAP colored Background

This is faily simple once we’ve set it up once and created a template to use for any future captions.
It’ll also give us the MAP colors to be able to use for recoloring clothes and adding it to text or shapes

Y, \'4

AW

W,

@eTno®

= Opacity: 100%
A Triangle Tool

-, lock: B ¢ b DY @ Al 100% -4 x 8
© Polygon Tool @
/ Line Tool o Bqul o ES* oy

&:? Custom Shape Tool
- E 8 * o Ol pjitacoal Double Click

Rearrange the newly created
Rectangle to below our
N character’s layer
Using the Rectangle tool we're
going a draw a one to the shape
and size of our entire canvas Next if we Double Click the empty space of the Rectangle
o

(The color doesn’t matter as we’ll layer it’ll bring up that layer’s Layer Style. Go down t
be placing an Overlay over it) Gradient Overlay as this will be where you can import my
custom MAP Gradient to use
Gradient Editor o X Layer Style X

Presets 5 Name: Rectangle 1

_ Gradient Overlay
) il Coud Styles Gradiant Cancel

N Blending Optons
i Iridescent 9 Blend Mode:  Normal

New Style...
Bevel & Emboss

Opacity; %
Preview
Contour Gradid Reverse
Texture Style: Unes @ Align with Layer

Stroks
. Angle: (¢ bl
Stroke
Scale:

Inner Shadow e
Delete Gradient... : Stripes

Inner Glow
New Gradient Preset... l Make Defaukt

New Gradient Group...

Reset to Default

Drop Shadow

Once imported or you’ve created your own, you can start using the adjustments
to alter how it appears as your background

Try adjusting these sections to make them appear in different ways
Style, Angle, Scale, Method, etc

Align with Layer: Checked
Style: Linear

Angle: 90°

Scale: 100%

Method: Perceptual

Align with Layer: Checked
Style: Linear

Angle: 72°

Scale: 105%

Method: Stripes




Recoloring Clothing - Part 1

We're going to use some of the same processes we used to select the character from the background but
just to select and mask out individual items of clothing

Now we need to
duplicate the layer for
each piece of clothing

we want to mask for
recoloring

@EeTnARN®

v Opacity: 100%

Fill: 100% v

Using the Object Selection
tool we're going to draw
around her bikini bottom to
create a new rough mask

Right Click the layer and
select Duplicate Layer or
hold Alt and drag the
layer above the main

© Gradient Overlay Q one %

Make sure you Delete the layer mask
for this next mask as we’ll be making a
new one (Also hide all other layers)

&\’.@’

This just has to be rough as we’ll
use the Brush tool to paint in any
bits that got missed

Make sure you see some dotted
Selection lines around the clothes

Show Edge (J)
Show Original (P)
i ity Once in the Select and Mask window
change Transparency to 50% to better
see where was missed

Bl () N

Clean up the mask using the Brush
tool getting the whole outline
(Just up to the black lines)

Rectangle 1

<> Gradient Overlay




Recoloring Clothing - Part 2

Time to repeat the same process
for her Bikini Top and anything
else you might want to recolor

R Organizing Tip:
o It’s a good idea to start putting i
o items in Groups and renaming
Layers
p—
Once things are a little more VR G G
organized, you should duplicate . 9 o AR
each masked clothing and place s b b B Rk 0% v
copy ontop of each other. Then v Cothes

set the Blending Mode to Vi Top
Multiply z

This is so we can use the above
layer to retain extra details once
colors are added

“3 (Keep the Layer Masks) /

Time to create a Rectangle for
each peace of clothing

Just get them in an approximate
size and shape to fully cover 08 . sy
each one

™ Rectangle 2

O Effects
O Gradient Overlay

Place them in the middle of each
set of clothing

You can now apply that same
MAP color Gradient Overlay we

used for the background Make sure the Angle is set to 90°

as we’ll be rotating them in the
next steps

L It doesn’t have to be Stripe you
could also use one of the other
Gradient Methods

hauelu8




Recoloring Clothing - Part 3

Time to get those Gradient
Rectangles into the shape of the of
the clothes

= NewLayer.. Shift+Ctrl+N

New Group...

New Layer... ShiftCtrl+N

New Group... Duplicate Layer...
Duplicate Layer... Delete Layer
Delete Layer

Quick Export as PNG ~ Shift+Ctrl+ On the Layer:
P el - Right Click > Create Clipping Mask

Quick Export as PNG  Shift+Ctrl+*
Export As... Alt+Shift+Ctrl+"

Merge Visible Shift+ Ctrl+E Merge Visible Shift+ Ctrl+E
Flatten Image ﬁ Flatten Image
Lock Layers... Ctrl+/ [ e Lock Layers... Ctri+/

Rename Layer...

Rename Layer..
Hide Layers Ctrls, Y

Hide Layers Ctrl+,

So we can warp the Gradients into the

Blending Options...

N same of the clothes and body time to e
lapse Al Groves i E T
Conveits Fome Convert those Rectangles into Smart |
- New Artboard... S onvert to Frame
‘ Artboard from Layers... Objects

New Artboard...
Convert to Smart Object L gntes s | avers...

Macl All Ohiects

Right Click > Convert to Smart Object

Content-Aware Scale  Alt+Shift+Ctrl+C
Puppet Warp
Perspective Warp

v mmmaansform Ctrl+T

Again ShiftCtrl+T To Warp the Rectangle
% Payers... .
Auto-Blend Layers.. sek Smart Objects:
Sky Replacement... Z:tate
ew
Def?ne Brush Preset... Distort ] L Ed |t > Tra nSfO rm > Wa rp
Define Pattern... Perspective
Define Custom Shape...
)m— | 2
Purge "..‘arp Horizontally —
Split Warp Vertically
Adobe PDF Presets...

You need to get all lines to look
like they’re flowing with the
shapes and contours of the body

Once the grid appears you can
start moving around the
squares, corners and ears of the
Warp Transform
It’s a little trial and error but
you’ll soon get it looking right

You can always revert the Warp




Recoloring Clothing - Part 4

She’s looking great but the
details ontop of the clothing
should be a bit more defined

We’re going to add an
Adjustment Layer with a Levels
Adjustment to the
uppermost Mask
(The one with the Multiple
Blend)

Properties  Adjustmen

Wi B Levels

Preset: Custom

Making sure we Check the
Clipping Mask for this
Adjustment Layer so it only
effects the Layer we want

Solid Color...
Gradient...
Pattern...

Exposure...

Vibrance...
Hue/Saturation...
Color Balance...
Black & White...
Photo Filter...
Channel Mixer...
Color Lookup...

Invert
Posterize...
Threshold...
Gradient Map...
Selective Color...

Adjusting the middle value you
can bring the contrast of the
Layer higher, deeping the
Shadows and Details

BEFORE

S |

r
3 Rectangle 1
Q?
e .

= eody

Ul

v [am Background

Ealtom

Background

o}
O Effects
© Gradient Overlay

AFTER

aos/Contrast...




Recoloring Clothing - Extras (Just Paint Your Colors)

Instead of just using our MAP gradient you can just paint the colors you need over the clothes you want
colored. This can be useful when the gradient shapes doesn’t completely cover parts of clothes
(e.g. Bra straps) or allow you to add custom decoration.

NO OVERLAY TWO LAYERS PAINTED WITH TWO COLORS

New Layer... Shift+Ctrl+N

New Group...
Duplicate Layer...
Delete Layer

Quick Export as PNG  Shift+Ctrl+'
Add a new Iayer in Export As... Alt+Shift+Ctrl+"
between our masks
and apply a Clipping
Mask to any layer you
want to Paint in

Merge Visible Shift+Ctrl+E
Flatten Image

Lock Layers... Ctrl+/
Rename Layer...
Hide Layers Ctrl+,

Blending Options...

New Group from Layers...
Collapse All Groups
Frame from Layers...

New Artboard...
Artboard from Layers...

- Select the Brush Tool
- Select a Color
- Pick a Brush type
(Diameter & Hardness)
=
Hold down Alt and move
mouse
left/right - Diameter
up/right - Hardness

&7 Penci
':'2/ Color Replacement Tool
8,/ Mixer Brush Tool

Get to painting

Use the Eraser tool to fix your
e You can use as many layers as

Same controls as Brush tool needed to get the design or
= look you're after.
Q . B <2 Eraser Tool E

@ Xﬁ' Background Eraser Tool E
¥# Magic Eraser Tool et B

- FE

Always best to use a different
layer per color




Recoloring Clothing - Extras (Different Colored Clothing)

For now we’ve only dealt with basic white colored clothing but sometimes you want to recolor an
item of clothing that’s a different color which if we repeated the original steps would give us the
wrong color reproduction when adding gradients/painted colors

Solid Color...
Gradient...
Pattern...

Brightness/Contrast...
Levels...
Curves...
Exposure...

( Hue/Saturation.

Black & White...
Photo Fitter...

Channel Mixer...
Color Lookup...

Invert
Posterize...
Threshold...
Gradient Map...
Selective Color...

This should work with any color
and possibly work with any

gradient colored clothes Apply a Hue/Saturation Adjustment
layer to this colored layer
(Only needs to be done on the
Multiply blend layer)

Bring the Saturation all the
way down to 0% and bring the
Lightness up to a mid gray
tone

8 - Hue/Saturation 1

Jop Multiply

To get the base back to white with black
outlines/details we’ll apply a Levels mmT L mals
Adjustment Layer to bring up the contrast s O Levels

Preset: Custom

Crush the upper value
and bring the middle
close to it to bring it

back to a more natural

white base

You can now follow the original steps to add the colors/gradients you'd like

Page 12



Recoloring Clothing - Extras (Removing Patterns)

Sometimes an item of clothing especially cute panties or t-shirts might have a pattern on it that you need to
remove as it’ll blend though any recoloring. This is why we always use Smart Objects so we can go back in
and re-edit the original material to fit our needs

saling Brush Tool

{4} Patch Tool
&S Content-Aware Move Tool
z) Red Eye Tool

Now it’s in an editible state (Original
Rasterized) you can open up the Remove tool

Open your reference image that
you’re working on by clicking on
the thumnbanil of the Smart
Object

You can also find other Healing/Patching tools
to in this context menue that might come in
useful for repairing artwork (especially Al
works with glitchy clothing elements)

This might take a few attempts Draw over the patch you want to remove
(Ctrl + Z) to undo any errors or simply and it’ll try to blend it in with the
repaint over it until it appears how surrounding area
you'd like

Repeat this process on all patterns, spots, blemishes till it’s a clean as you can get it

If you wanted to keep a styled piece like the bow in this example. Just duplicate the
layer and mask it out so it won’t be edited and can be placed above all other layers %@@ 13



Text & Layer Styles - Part 1

Now that you’ve got some proper MAP Flag representation in your piece. It’s time give it some more
flourishes and add some text on the screen for you and the viewer to enjoy

Using the Text tool you can start typing
anywhere

* Vertical Type Mask Tool
orizontal Type Mask Too (The font used is Railway Gank)

ﬁ} The color used W|Il be
whichever is default I
in your color RE A
selection box
(Same as with
brushes/shapes)

If you want to change the color of just one
letter/work just hight over it with your cursor

4

Add to Swatches AL opt >
current T TITT: T |

Color Libraries
4 M fi /
I O H: S g English: USA 3 @
S: % E - ar:
R:
G:

Only Web Colors

In the Character window

you can change the font, @
size and other formating
options but for now we’ll i
RG-S el)s Moving your cursor outside the color
selection and onto the canvas you it’ll
change into the Eyedropper tool
allowing you to pick a color off your

background or anything else

(Double Click on Color Box)

It’s starting to look good but we’re not able
to properly see all the colored text, so for
now we’re going to add a Stroke & Drop
Shadow this Text layer’s Layer Styles

So the black text doesn’t stand out so much we can go back

and swap that out as well
hayeNid



Text & Layer Styles - Part 2

We could leave it there but for now we’ll be adding a couple more Layer Styles to make it
stand out over everything else

To get this new style we’ll be keeping
the Stoke & Drop Shadow

Then going back into the text’s Layer
Style to start adding a few more effects

TO THIS

Time to add back our
custom MAP graident with a
Gradient Overlay and adjust
the size as need to really fill

both parts of the entire
sentence

Now an Outer Shadow might
not be really necessary but it
can help lighten up some
parts of artwork behind it

To give some 3D
dimensionality to the text
Oeo the Bevel & Emboss style
EeE s will make it look less flat

Pattern Overlay.

G = - overall

9 Drop Shadow

There are so many powerful things you can do with this style so try copying
these settings as is and then start adjusting each value.

The main values to adjust are Size, Soften & Depth along with the colors
and opacity of the Hightlights/Shadows

Hauella



Text & Layer Styles - Part 3

— —
To add some warps to
the text to get it like the

example open up the
Warp Text window

Warp Text X

O Arc Lower
() Arc Upper
Here you can choose from a

whole lot of Styles but for this
one we’re just going to use
Bulge at Bend of +22%
Warp Text X

Style: © Bulge

© Horizontal Vertical

>
i =

Horizontal Distortion:

Vertical Distortion:

ext is a simple rotation with
Ctrl + T to bring up Transform controls

If you put your cursor near the corner or point of the
bounding box it will allow you to rotate the image

Add some more text to your caption to complete the vibe or
messaging you’re going for




Text & Layer Styles - Extras - Part 1

Maybe you also want to emphasize a particular focus in your scene, either with some arrows pointing at
something or even a stylized circle

Let’s create a simple circle with Draw it over the area you'd like
the Elipse tool holding down Shift + Alt to

center it
And create a stroke instead

(Pick any color & line thickness as needed) Instead of having it filled in with

a color we can remove the fill

@. e: A74px v ==
i)

E k window

ntly Used Colors &*

ENEEEEE EEE

Recently Used Colors &*.
EEEEEEE BEEE

) Il RGB

) i RGB
) il oMYK

) M Grayscale
) Il CMYK
) M Pastel
) Il Grayscale
) il Ught
) Wl Pastel

) i Pure 3
) i Ught

) il Dark _
) il Pure

) W Darker

Time to give it a dashed line look > I ouk
by selecting Stroke Options ) I ok

21.74 px ™ : 798.12p GO
| Stroke Options : Using the line thickness tool this
will evening add more or less
dashes to fit around your circle

1

You can now add a gradient to @
the cirlce in Layer Styles
But instead of a Linear Style
we’ll switch it to Angle and
then adjust the angle so

they’re not abrupt stop to the
gradient

(You want the gradient cut off

to appear in between the
dashes)

Rayehl



Text & Layer Styles (Extras) - Part 2

Using the Text tool we can hover Select all the auto-filled in text
and click on edge of the circle to by holding Ctrl + A Replace the text as needed
start writing around it making sure to add spaces in

between the words

i Press Ctrl + T so you can scale it
& You can apply the same gradient to this layer but flip the around the cirle and Shift + Alt

angle so it mirrors with circle’s gradient
~ [ Cunny
O Effects
O Stroke
O Stroke
©O Satin
Outer Glow
© Drop Shadow
o

T CUNNY CUNNY CU... CUNNY CUNNY fX .

to scale in on the center

O Effects
Stroke
O Gradient Overlay

Ellpse 1
E

O Effects
Stroke
O Gradient Overlay

You and double up the Stoke effect Set the Group Blend mode to
with one being smallest in Blacked and  Overlay so you can see through
a slightly bigger on in White, along it slightly
with a drop shadow

Place both Text & Shape layers in
a folder so you apply more Layer
Styles over all the them

As the overall group of Text & dashed Circle now appear too washed out adding a Hue &
Saturation Adjustment Layer both of them within the Group you can boost up the

Saturation and bring down the Lightness %g@ ﬂ



Tattoos & Decals - Part 1

Time to add some tattoos to you your caption. We want to make sure we can blend them
seamlessly onto your characters just let they were meant to be there

New Layer... Shift+Ctrl+N
New Group...
Duplicate Layer...

Delete Layer

Quick Export as PNG  Shift+Ctrl="

S
&
04, Q
(}S’

Export As... AltsShift+Ctrl+*
Merge Visible Shift+Ctrl+E
Flatten Image

Lock Layers... Ctrl+/
Rename Layer..

Hide Layers Ctrls,

Blending Options...

T8 New Group from Layers..

Collapse All Groups

| Frame from Layers..

END RESULT
Take your tattoo or decal and e
- oo | | place it in a rough position on

T Scle \ your character. Then Convert to
uto-B r ol Paste Layer Style
Sk Replacemen. Skew Smart Object if it wasn’t Copy €55
Define Brush Preset... Distort . Copy SVG
Defneate. Perspective imported as so ~
efine Custom Shape. _ olor 4

> La!y: Horizontally ﬂ 7

Once you have it as a Smart Q/

Object you can now do a basic
rotation ready to begin a Warp
Transform

Warp it around the curves to get
it as close as you can. You can
always adjust the Warp later

To give you Warp some more
twists and manipulations hold
Cntrl over a section of the Warp
grid to add and extra point of

adjustment

Twist your Warp to your
liking for now ready for
the next steps of blending
it into the skin

hauely



Tattoos & Decals - Part 2

Give the tattoo some extra
hightlights/shadowing by adding
an Bevel & Emboss effect

Change the Angle and Size to try
and replicate the original
character lighting

Under the Layer’s Blending
Options we can Blend the
Underlying Layer through our
tattoo

Start with widening the Whites
and then Black levels

Hold Alt and Click the value to

% split the adjustment

Cancel
New Style...

@ Preview

Cancel

New Style...

Color Picker (Overlay Color)

e

new
. H
n
curent

O H:

Color Librat

N 82
;20

1

oK
Cancel
Add to Swat

Sometimes with darker tinted
tattoos they might not match
the black levels of characters or

] the scene.

Using a Color Overlay and a
Muliply Blend, Eyedropper tool
the shadow skin tones to get
that slight color tint

ches
ries

M: 31 9%

Only Web Colors

If you want to place a tattoo on the edge of a character
you can convert that layer into a Clipping Mask so it
can only appear on that character’s Layer

O Bevel & Emboss

A similar effect can be created be drawing a mask
around the characters body part but then apply that
mask to your tattoo. This can show or hide parts of it




Tattoos & Decals - Part 3

Maybe you want to change up the eyes and add some hearts/spirals/etc to them

- %
Layer 0

{4} Patch Tool
&% Content-Aware Move Tool
’L(.) Red Eye Tool

‘V Bring in your Heart \V E .
asset N
Scale, Rotate, Warp Use the Remove tool to »
it as needed auto replace the
/ highlight in both eyes
S e —
® i oo <8 T

Go into the Smart Object of the
original image and duplicate it

As this is black asset we’ll want to

add a Color Overal to have it match \ / g Underlying Layer value to fade it
the highlights of the eye slightly in

Under Blending Options edit the

W LayerStyle

\J Layer Style

Next either use the Bevel &
Embose too or a Satin effect and

o sﬂe:v - adjust it to appear more 3D
O el 0SS

© Color Overlay [ Loyer Sele
Name:  Heart
0 Heart k:imm
O Effects inner Bew
9 s

O Bevel & Emboss
© Color Overlay

Copy the eye to the other eye
socket and you should be finished

LW

)

You maybe need to adjust the
Scale/Rotation/Warp to fit
more realistically
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Layer Style

Blending Options
Bevel & Emboss
Contour

Texture

Stroke

Inner Shadow

Inner Glow

Gradient Overlay
Pattern Overlay
Outer Glow

Drop Shadow

Editing Background - Part 1

Sometime you want to go for something a little different and stylized for your character

background so we’ll complete this caption a few options

g © Drop Shadow

Stroke

For this caption we’ve
added an extra white Stoke
& Shadow to make it stand

out along with adding

another gradient as a o Structure

Blending Options
See: g

border Bevel & Embss I outsice

Contour Blend Mode:  Normal

Layer Style

Texture Opacity:

T Overprint
e
il Type:
Inner Shadow FAType: | Clor

Inner Glow

Blend Mode: | Multiply

Opacity: a si

T Adding a basic Outside white
: Stroke and then adding a Drop
Dropshadow our character
' now stands out from the

=y background

Nose: & 0

Layer Knocks Out Drop Shadow

Make Default Reset to Default

v [ Background

MAP Background

Effects
Gradient Overlay

Box
8]
Lower Background

Create another Rectangle or
duplicate the MAP background
to change up the gradient

© “m Background

O (EI MAP Background

O Effects
O Gradient Overlay

Create one final Rectangle and
© [Q Roc make it the size of the inner
o r o Background you want to use

Set the MAP Background to a
Clipping Mask of the Box and you
can also add a Drop Shadow to
the Box
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Editing Background - Part 2

Changing up the background style is faily simiple with some Smart Filters

Layer Style X

For the bacground we’ve

changed the Style to = S =
. Reflective, reset the angle s =4 New Soe..

Preview

& reduced the scale of
the gradient

3 Algn with Layer

E3

e
Scale:
Inner Shadow
Method:  Stripes
Inner Glow
Make Default Reset to Default
Satin
Color Overkay
(3 Gradient Overlay
Pattern Overlay

Outer Glow

Drop Shadow Mask i wajeees

©O Gaussian Blur fx

Oitnil Convert the background to a Smart Object

so we can apply some Smart Filters

ilter View Plugins Window Help

AltsCtrl+F

Convert for Smart Filters
rial Project.psd @ 38.8% ({

Neural Filters..

Filter Gallery...

Adaptive Wide Angle... ~AltsShift+Ctrl+ A

Camera Raw Fiter... Shift+ Ctrle A

Lens Correction... Shift+ Ctrl+R

Liquify... ShiftsCtrl+X

@ Vanishing Point. Alt+Ctrl+V

Blur »

ProrQary »

Ged) e
»  Pinch..

Pixelate »  Polar Coordinates...

Render > Ripple..

Sharpen > Shear..
»

Stylize
Video
Other

Set the Angle to as high as you'd like Go into Filters > Distort > Twirl

Filter View Plugins Window Help

Alt+Ctrl+F

Twirl

Convert for Smart Filters
rial Project.psd @ 38,

Neural Filters...
Filter Gallery...
Adaptive Wide Angle... ~ Alt+ShiftsCtrl+A
Camera Raw Filter... Shift+Ctri+A
Lens Correction... Shift+Ctrl+R
Liquify... Shift+ Ctrl+X

Vanishing Point... Alt+Crl+V

Average
Blur
Blur More

Sharpen : Motion Blur...
Stylize »  Radial Blur...
Video b ShapeBlur...
Other » Smart Blur...
B
As it’s a Smart Object we can expand the size of the Go into Filters > Blur > Gaussian Blur

Transform to get the spiral in the middle

Gaussian Blur X

Cancel

Set the Radius to
whichever strenght
you'd prefer whilst

looking at the preview
or how it’s effecting the
canvas

ENE

Radius: 16.6 Pixels
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Advanced Editing (Decensoring)

Artwork or references taken from Japanese Artists might have some basic line censoring to them.
These are actually the easist to remove and paint back in

é’ Spot Healing Brush Tool

These censor lines come in all * & RemoveTodl
sorts of colors and styles but & Healing Brush "ol
with the Remove tool they’re {# Patch Tool

simple to uncensor x Content-Aware Move Tool J
® Red Eye Tool )

Make the size of your Remove tool Brush
to be slighty bigger than the line you
Once brushed out you should see the want to paint out
line disappear with all colors & shapes
joined back up underneath

- 7 -

Repeat the process on all censor lines

You can go over already worked on
uncensoring to fix any errors

You should now be left with a clean
uncensor especially once fully zoomed
out to the entire piece

hauel



Resources: (Websites to find material)

Getting high-quality images to start editing with is easier than ever!
Here’s a list of some popular sites to download from

Website

exhentai.org
imhentai.xxx
hitomi.la
simplyhentai.org

booru.allthefallen.moe
chan.sankakucomplex.com
gelbooru.com

7chan.org/cake/
7chan.org/sh/ & /ss/
chan.moe/loli/
meta.kiwi.st/d/

pixiv.net
baraag.net

kemono.cr
nekohouse.su

allthefallen.moe/forum
roriwalrus.com
shotaworld.com

pomf.tv

Type

Gallery
Gallery
Gallery
Gallery

Booru
Booru
Bouru

Chan
Chan
Chan
Chan

Official Artist Pages
Official Artist Pages

Premium Artist Leaks
Premium Aritst Leaks

Forum
Forum
Forum

Artist/Gaming Live Streams

Tags

Loli, Shota, Todcon, Al
Loli, Shota

Loli, Shota, Todcon
Loli, Shota

Loli, Shota, Todcon, Al
Loli, Shota, Todcon, Al
Loli, Shota, Al

Loli, Al

Shota, Al

Loli, Al

Loli, Shota, Todcon, MAP, Al

Loli, Shota, Todcon, Al
Loli, Shota, Todcon

Loli, Shota, Todcon, Al
Loli, Shota, Todcon, Al

Loli, Shota, Todcon, Al
Loli, Shota, Al
Loli, Shota

Loli, Shota, Todcon

Make sure you’re always downloading the highest quality

Open Image in New Tab

Sayve Image As...

Copy Image

Copy Image Link

Email Image...

File name: [ sample-ffb0f2326e148737b671bcb5822805f3.png

Save as type: vIrfanView PNG File (*.png)

File name: [ #fb0f2326€148737b671 bcb5822805f3.png

Save as type: vIrfanView PNG File (*.png)

If you normally just right
click an image to download
when the download
dialogue pops up make sure
it doesn’t say sample

X

Instead check to see if
there’s a download button et

Images above
1000 x 1000 px
are recommended

version of an image to make your edits out of!!!

Information
ID: 1258250
Uploader: Dr

Approver: Anotherne

that tells you the original file |[EEESEEEIY S
size & dimenions

Soul

Rating: Questionable
Score: 498 §
Favorites:

Status: Active

Options

° kanna kamui (kobayashi-san c...6e148737b671bcb5822805f3.png
Completed — 4.6 MB ; )
Show all downloads

072x3072)

haueys



Resources: (Pre-made Assets)

Along with this guide there should be a few links to asset packs for
various textures/gradients/tattoo/decals/bodyparts/scripts/etc

Resources

999.25 MB (41 folders and 1741 files)

If you found this guide from the original post
links should be in a reply to it

If this guide got reposted elsewhere please
ask the uploader to give you the links to all
assets mentioned

Apart from the pre-made assets packs there are plenty of other websites to
get more elements to add to your work

N
PNGIT.EM

There are many sites that can give you high
quality PNG images with transparency

Millions of Hand-picked & Pure HD PNG Images For
Free Unlimited Download These are just a couple

Popular Tags: Cross Cloud Christmas HeartEmoji Facebooklcon Flower Money Ribbon pl XQbQ' l

Stunning free stock photos for download

Explore lllustrations ~ Vectors  Videos ~ Music  Sound Effects 3D Models |NEW. GIFs

Q  search for photos

nature flowers sky wallpaper office forest background  sunset cat beach dog money iphone wallpaper

DuckDuckGo,

If all else fails just search for what you’re
looking for off a search engine. Just make sure
you size the search size to be the highest
available

Haue



Resources: (Additional Software)

There are a few extra FREE programs you can use to help you with
editings and keeping things organized

nexusfont
Bl NexusFont - b .
T = This is a few Font manager which loads
@ @ W [T quckorown foxjompeover the oz dog. B up all Fonts that are installs and allow
- P you to preview what text might looks like
S T o in a bunch of sizes, colors & font styles

The quick brown fox jumps over the lazy dog.

&8 Tr Bodoni MT Black

This is a sample text in English! Get from: xiles.app
The quick brown fox jumps over the lazy dog.

8 Tr Bodoni MT Black Italic

This is a sample text in English!
The quick brown fox jumps over the lazy dog.

& Tr Bodoni MT Bold

This is a sample text in English!
The quick brown fox jumps over the lazy dog.

&8 Tr Bodoni MT Bold Italic

This is a sample text in English!
The quick brown fox jumps over the lazy dog.

&8 Tr Bodoni MT Condensed

This is a sample text in English!
The quick brown fox jumps over the lazy dog.

408 fonts, 387.50 MB

A great place to get various Fonts in
different styles to meet your creative

needs Fre e CTEEN CIEN CITTE Geode  (ITEN
Decorative ° 2 . = 5 Nature =
Cartoon Typewriter Chinese, Jpn Square Medieval Sans serif Calligraphy Alien Sport Valentine
Comic Stencil, Army ~ Arabic LCD Modern Serif School Animals Heads Easter
Groovy Retro Mexican Sci-fi Celtic Fixed width Handwritten Asian Kids Halloween
. old School Initials Roman, Greek  Various Initials Various Brush Ancient TV, Movie Christmas
Get from: dafont.com Curly ot Russian Various Trach Runes, Eiish  Lugin Various
Western Various Various Graffiti Esoteric Sexy
Eroded = 3 Old School Fantastic Army
Distorted Pixel, Bitmap Various Horror Music
Destroy Games Various
Horror Shapes

LATNVIEW
" One of the most popular viewers you can use with

a bunch of useful features that should help you
keep your assets organized

O a— (You can crop and copy aparts of assets from
EBSHCR -~ 2B 98 IrfanView to paste into Photoshop)

Get from: irfanview.com
(Download & Install plugins as well)

=

Color Picker is a system-wide color picking utility G Glor e x|
activated with Win+Shift+C s 0000000 D © |
‘ cbb6ac 0
It allows you to pick colors from anywhere on the ‘ .
screen, and the picker automatically copies the o ‘ o ]
color to your clipboard in a specified format | i

Get from: github.com/microsoft/PowerToys




Credits:

Reference image for QA Testers:

this caption tutorial

@STE\‘EB1 2724 m ANON rﬁ . To be added in V1.1

Created by:

Inspiration for this guide
@ Awesome Caption Makers @




